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1. What does the system affinity mask indicate?
» The active process masks
» The Windows version
» The number of threads
» The number of processors on the System  TOPIC 126
2. How much virtual address space is consumed by 100 threads?
> 100MB
> 1GB CONCEPT
> 10GB
] TR
3. What is default stack size for each thread in a memory?
» 100MB
> 1GB
> 1MB TOPIC 126
> 10MB
4. What type of Lock is an SRW LOCK?
» Kernel Lock & Spin Lock
» Spin Lock & Shared Lock
» Exclusive Lock and Shared Lock TOPIC 174
» Shard Lock Only
5. Which is Fastest Locking mechanism
s SRW Lock

« Mutex
¢ Interlocked Function TOPIC 174
¢+ Critical Section

6. API open an Existing threads handler from a Thread ID.

» GetThreadID()
» GetcurrentThreadld()

» OpenThread() TOPIC 114
» GetCurrentThread()
7. The use of ensure that the main memory is updated and catch of all the processor
is coherent.
» Memory Barrier TOPIC 134

» Volatile qualifier & Global Flag
» Volatile qualifier
» Global Flag
8. For Mutual exclusion to work variables() must be protected by a single
synchronization object across all threads.
» Important
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» Local
» Shared TOPIC 141
» Local Integer
9. What is the size of an SRW Lock?
> 32 bits & 16 bits
> 64 bits & 8 bits
> 8 bits & 16 bits
> 32 bits & 64 bits TOPIC 163
10. What is the purpose of a critical section in a program with a mutex?
» To define a specific of code that can only be executed by one thread at a time
CONCEPT
» To allocate memory dynamically
» To create a user interface
» To calculate mathematical expression

11. Inherited Handlers of parent and Child processor have copies and own states.
» Similar
» Distinct TOPIC 92
» Related
» Connected
12. When CreateThreadpoolWork() is called then is(are) executed using the process
thread pool?
» Callback Functions TOPIC 173

» Kernel Functions
» Kernal Routines
» Work Object Code
13. If you want to create 4 thread i.e, thread 0, thread 1, thread 2, and thread 3, they all must
be created at state.
Suspended TOPIC 120
Block
Running
Ready
14. Function is used to return the address of the currently running fiber.
GetCurrentFuber() TOPIC 129
GetFiberDate()
GetFiberld()
GetFiberldentity()
15. A fiber can obtain its identity by calling  API
» GetCurrentFuber() TOPIC 129
» GetFiberDate()
» GetFiberld()
» GetFiberldentity()
16. A fiber can obtain their data by calling  API
» GetCurrentFuber()

YV V VYV V

YV VYV
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17

18

19

20

21

>
>
>

GetFiberDate() TOPIC 129
GetFiberld()
GetFiberldentity()

. A fiber can be created by using threads

>
>
>
>

GetCurrentFuber()

CreatFiber() TOPIC 129
GetFiberld()

GetFiberldentity()

. A fiber can gives control

>
>
>
>

GetCurrentFuber()

SwitchToFiber() TOPIC 129
GetFiberld()

GetFiberldentity()

. Which fiber can be deleting using Threads

>
>
>
>

GetCurrentFuber()

DeleteFiber() TOPIC 129
GetFiberld()

GetFiberldentity()

. For the efficient use of critical Section and mutex, the thread priority should be decided

by the

>
>
>
>

Program

OS Scheduler TOPIC 154
Mutex

Critical Section

. If entry point of DLL is not specified, then it is an example of

YV VYV V

22.

23

24

YV VYV

Explicit
Implicit TOPIC 183
Explicit & Implicit
Dynamic

can be used to assign a thread to a specific processor
Memory Management Unit
Device Driver
Process Affinity TOPIC 179
Loader

. How does a Mutex provide synchronization in a program?

>
>
>
>

By Locking access to shared resources TOPIC 138
By allocating memory dynamically

By creating a user interface

By calculating mathematical Expression

. A process have ID(s) and handle(s)

>
>

Unique,unique

Unique,multiple CINCEPTUAL
A process has one Process ID and one or more handles.

linking.
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25.

26.

27.

28.

29.

30.

31.

» Multiple,multiple
» Multiple,unique

Which of the following synchronization construct is used for semaphore
> Enter
» Leave
> Wait TOPIC 96
> Set

A thread can enter _ time(s) into its critical Section at different instance in thread
synchronization.

» Only one CONCEPTUAL

> Several CONCEPTUAL

» Exactly Ten

» At suspended
How many number of Times parameter are provided to a GetProcessTime() API to
compute the elapsed time of process?

» 0 No given answer because it has 5 parameters

NOTE: No specific number of times parameter is required to compute the
elapsed time of a process using GetProcessTimes() SO answer is 0.

> 1

> 2

> 3
Producer consumer problem is a classical problem in

» Multi exclusion

» Mutual process

» Mutual exclusion TOPIC 142

» Object exclusion
Which of the following is not a thread model

» Peer to peer TOPIC 119

» Boss worker

» Client-server

» Pipeline
The use of global variable flag in the solution of the critical section problem suffers or
fails due to the of threads.

» Deadlock condition

» Sleeping condition

» Hold and Wait Condition NOT SURE CONFIRM it ACCORDINGLY

» Context switch
In Thread Local Storage (TLS) arrangement row represents  While column
represent

» Thread Number, TSL index TOPIC 123

» TLS index, Thread Number

» Thread number, process Number

» Process Number, TSL index
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32.

33.

34.

3y

36.

37.

38.

39.

40.

When all the threads of a process are made exit or terminate, then the process
» Will still survive
» Will terminate TOPIC 113
» Will terminate for specified period of time
» Will temporarily suspended
In a GetProcessTime() API, the elapsed time of a process can be computed by subtracting
the
» ExitTime from CreationTime parameter
» CreationTime from ExitTime Parameter TOPIC 100
» UserTime from ExitTime parameter
» ExitTime from UserTime Paramater
How can you specify a manual-reset event?
» By Setting bManualReset to FALSE
» By Setting bManualReset to TRUE TOPIC 150
» By Setting blnitialState to FALSE
» By Setting OpenEvent to TRUE
ReadFile() and WriteFile() functions perform much  then memory mapped file
processing.
» Faster
» Convenient
» Slower TOPIC 71
» Nimble
File processing is than ReadFile() and WriteFile().
» Faster TOPIC 71
» Convenient
» Slower
» Nimble
Which function is used to obtained the psuedohandle?
» GetCurrentProcess() TOPIC 93
» OpenProcess()
» CreateProcess()
» GetCurrentProcesslId()
Which function is used to obtained the actual handle of a process?
» GetCurrentProcess()
» OpenProcess() TOPIC 93
» CreateProcess()
» GetCurrentProcessld()
We provide parameter of the WaitForSingleObject() API.
> 0
> 1
> 2 TOPIC 116
> 3
Windows treats threads as
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% Objects TOPIC 116

% Processes
% Classes
41. For Sequential files, File mapping may reduce the processing time by  folds as
compared to conventional File operations.
» Three TOPIC 76
» Six
» Nine
» Ten
42. If the Functions inside the DLL are uploaded, then older program attached to this DLL
will not work properly. This statement refers to  of DLL versioning.
» Strength
» Problem TOPIC 86
» Advantage
» Caution
43. Which statement is incorrect when processors are made synchronized?
» It can decrease the overhead of system
» It can increase the overhead of system CONCEPTUAL
» Some process can be blocked in synchronization
» Mutual Exclusion is achieved
44. When any key is pressed from the keyboard, the scan code of that key will be sent at
port
» Port 40
» Port 20
» Port 80
» Port 60 CONCEPTUAL
45. What is the purpose of set functions for the mask?
» To restrict access to the system
» To control the scheduling of threads
» To set affinity mask for process It’s my OWN knowledge
» To set the affinity mask for another process or for itself
46. The generic syntax for declaring bases pointers in Windows is
» Type based (base) declarator TOPIC 178
» Declarator tyoe based (base)
» Type (base) declarator based
» Type declarator based(base)
47. Which of the following is return type of CreateThreadPoolWork() API?
» LPVOID
» PTP_WORK TOPIC 169
» PTP _CALLBACKL
» PTP_WORK CALLBACK
48. What is the function of the masks in the System?
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49.

50.

al.

52.

53.

54.

55.

» To restrict access to the system
» To control the scheduling of threads
» To set the affinity mask for a process
» To set the affinity mask for another process
Which parameter is required to be pass to the EXITThread() API?
» ThreadlD
» Thread Object name
» Both Thread ID its Object name
» Thread EXITCODE TOPIC 113
Using ExitProcess() function a process can be made exit or terminate. Which of the
following parameters is required to pass the function to make this execution successful
» process's real handle
» Process's pseudo handle
> Process's ID
» Process ExitCode TOPIC 95
Dynamic memory is allocated from the
» Paging file TOPIC 71
» Stack
» Static memory
» Cache
While using MapViewOfFile(), which of the following are the three commonly used
flags?
» FILE WRITE, FILE READ, AND FILE ALL ACCESS
» FILE MAP WRITE, FILE MAP READ,AND FILE MAP ALL ACCESS
TOPIC 74
» MAP WRITE,MAP READ, AND MAP AL ACCESS
» WRITE, READ, AND ALL ACCESS
Each  is aunit withinthe
» Thread, process TOPIC 87
» Process, Thread
» Kernel, Process
» Process, kernel

Window OS does not have any struct that keeps track record of the ~ process.
» Parent-child TOPIC 88
» Child
» Parent

» Independent
To executable image name of a process in a CreateProcess() API is specified by
parameter(s).

» IpApplicationName only

» IpCommandLine Only

» Either IpApplicationName or IpCommandLine TOPIC 90

» Neither IpApplicationName or [pCommandLine
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38.

59.

60.

61.

62.

63.

64.

. IpApplicationName handle’s value  be NULL.

Should not TOPIC 90
May not

May

should

. A DLL can the function

» Only export
»  Only Import
» Export and Import CONCEPT
» Neither export and import
Optimal Spin-count ensure
» Less system calls TOPIC 162
» More System Call
» More overheads
» Critical Sections Overhead
By default, the ~ makes scheduling decisions and allocates processors to each thread.
» System programmer
» Kernel TOPIC 179
» BIOS
» Loader
API opens an existing thread’s Handle from a thread ID.
» GrtThreadld()
» GetCurrentThreadld()
» GetCurrentThread()
» OpenThread() TOPIC 114
__API creates thread handle from a threadID.
» GrtThreadld()
» GetCurrentThreadld()
» GetCurrentThread()
» OpenThread() TOPIC 114
Each process must have at least thread
> 0
> 1 CONCEPTUAL
> 2
> 3
Which of the following is return type of CreateMutex() API?
» VOID
» LPVOID
» HANDLE TOPIC 144
» BOOL
Which of the following is return type of ReleaseMutex() API?
» VOID
» LPVOID
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65.

66.

67.

68.

69.

70.

71.

72.

» BOOL TOPIC 144
» HANDLE
What is an interlocked function in C++?
» A function that performs non-atomic operations
» A function that performs atomic operation CONCEPTUAL
» A function that performs complex operator
» A function that performs basic operations
What is Deadlock?
» A situation when two or more processes are executing in parallel. CONCEPT
» A situation when two or more processes are blocked temporally, waiting for each
other.
» A situation when two or more processes are abandoned.
» A situation when two or more processes are blocked Identically, waiting for each
other.
What is the purpose of Spin count in SRW lock?
» To support recursion
» To determine the size of the lock
» To reduce the overhead of context switches CONCEPT
» To allow configuration or adjustment
What is range of clock rates for most system today?
» 0-1GHz
> 1-2GHz
> 2-3GHz TOPIC 175
» 3-4GHZ
How are the set Functions used?
» With Thread and process handles
» With System and Thread handles CONCEPTUAL
» With Process and Memory Handled
» With input and output handle
How we can determine the number of processors from the system affinity mask?
» By Counting the number of bits set CONCEPTUAL
» By calling the windows version
» By using a simple program
» By cutting the number word set
If invalid file handle is passed as parameter to CloseFiile() API, then it will be return_
» True value
» False Value TOPIC 15
» A new Handle
» Close a handle
[f the file is not opened in concurrent mode, then ReadFile() API starts reading from
the
» Start of file
» Current position TOPIC 33
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73

74.

75.

76.

7.

78.

79.

80.

» End of File
» Backup of File

. The exception handler is actually a code portion associated with ___ block.
> finally
> -try
> -except TOPIC 48
» -catch
Itis to refer to a mapping file multiple times while using parameter as data
structure.
» Useful TOPIC 72
» Meaning
» Necessary
» Optional
Which option is incorrect when the TraverseDirectory() API is required to be used?

» It allow non-recursive traversal
» Recursive and non-recursive traversal option is irrelevant
» It allows recursive traversal
» It allows both non- recursive and recursive traversal
The Filter Function the type of an exception.
» ldentifies TOPIC 58
» Evaluates
» Excludes
» Restricts
If binary Functions inside DLL are accessed at load time, the called as
» Explicit linking
» Implicit linking TOPIC 80
» Both implicit & Explicit
» Thread Linking
The producer also computes a simple of the message
» Checksum TOPIC 142
> cheksub
> checkdive
» checkmul
Windows provide an object called a . Using this object, we can enforce mutual
exclusion
» Multex
» Multask
» Mutex TOPIC 144
» Mutext
procedure consumer problem is a classical problem in
» Mutual exclusion TOPIC 142
» Mutual process
» Multi exclusion
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» Object exclusion
81. Mutexes have advantages beyond CRITICAL SECTION. Mutex can be named and

have
» Sections
» Timers
» Handles TOPIC 144
» Self-loop
82. Which of the following synchronization objects is not a named object?
» Critical section TOPIC 138

NOTE: ALL names are given and Nearly to close answer is CRITICAL
SECTION because it can be only used in syncronize

» Mutex
» Semaphore
» Event
83. To minimize the concurrency related issue
» Mutex is unlocked on entry and locked on exit TOPIC 154
» Size of the critical region should be Minimized
» Premature exits from the critical region are necessary
» Critical Region must have more than one entry
84. According to the MSDN the optimal spin count for heap related function is___

> 3000
> 4000 TOPIC 162
> 5000
> 6000
85. A(n) s acollection of worker threads that execute asynchronization callback on

behalf of the application.
» Address Space
» Thread pool TOPIC 172
» Callback Function
» Environmental Variables
86. Indicates the processors configured on the system
Process Affinity mask
Processor Affinity Mask System Affinity Mask: TOPIC 180
Thread Affinity Mask
Kernel Affinity Mask
NOTE:
The actual answer is System Affinity Mask:

VVVYV

87. indicates the processors that can be used by the process threads
» Process Affinity mask TOPIC 180
» Processor Affinity Mask
» Thread Affinity Mask
» Kernel Affinity Mask
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can be used assign a thread to a specific processor
Process Affinity mask TOPIC 180
Processor Affinity Mask
Thread Affinity Mask
Kernel Affinity Mask
89. Each thread has a thread affinity mask which is a subset of process affinity mask.
» Process Affinity mask
» Processor Affinity Mask
» Thread Affinity Mask TOPIC 180
» Kernel Affinity Mask
90. Thread Affinity Mask is subset of
Process Affinity mask TOPIC 180
Processor Affinity Mask
Thread Affinity Mask
Kernel Affinity Mask
91. A API is used to create a single threaded child process.
CreateFile()
CreateProcess()
CreateThread() TOPIC 112
CreateProcessThread()
92. Total number of parameters required for CreateProcess() API is
> 9
> 10 TOPIC 88
> 11
> 12
93. From which structure, we obtain the newly created child process’s handle and ID?
LPSTARTUPINFO structure
LPPROCESS INFORMATION structure TOPIC 89
IpEnvironment Variable
LPSECURITY_ATTRIBUTES
94. API is used to map a view of a file-mapping object into the address space of a
calling process.
» CreateViewOfFile()
» MapViewOfFile() TOPIC 74
» CreateFileMapping()
» OpenFileMapping()
95. Which one is not a disadvantage of the static linking during compilations?
» A big executable file
» Takes more space on disk
» Take less physical memory TOPIC 180
» Consume more bandwidth
96. In Implicit linking, the library functions are linked to the source code at
»  Written time
» Compile time
» Run time
» Load time TOPIC 80
97. In Explicit linking, the library functions are linked to the source code at
»  Written time

YV VYV V

YV VYV V

Y V VYV

Y VV YV
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» Compile time
» Load time
> Run time TOPIC 80

98. In which type of linking, the DLLs are not used?
» Static linking TOPIC 80
» Explicit Linking only
» Implicit linking only
» Both Implicit and Explicit linking
99. The CreateProcess() API returns handle(s) after successful execution.
Zero
One
Two TOPIC 88
Three
The return type of ExitProcess() APIis .
DWORD
LPTSTR
HANDLE
VOID TOPIC 95
The number of parameters required for TerminateProcess() APl is
1
2 TOPIC 95
3
4
102. After loading a DLL explicitly, we can obtain the address of any entry point in DLL using
the function J
GetModuleHandle
GetProcAddress() TOPIC 83
LoadLibrary()
LoadLibraryEx()
The number of parameters required for CreateJobObject() API is
0
1
2 TOPIC 108
3
The return type of CreateThread() API is !
DWORD
LPDWOR
HANDLE TOPIC 112
LPTSTR
The default stack size for a thread is :
1 MB TOPIC 126
1 KB
1 Byte
1 bit
The number of parameters required for GetExitCodeThread() API is
0
1
2 TOPIC 113
3
107. TLS stands for

100.

101.

VVVY VVVYVY VVYVYVYV

103.

104.

105.

106.

VVVY VVVY VVVV VVVVY VVVYVY
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Thread Local Storage TOPIC 111

Thread Last State

Thread Local Size

Timestamp Local Storage

108. A unit of execution that is scheduled by the application rather than by the OS Kernel, is
called as .

Fiber TOPIC 180

Thread

Process

Mutex

A fiber can obtain its starting address by using the API

CreateFiber()

GetFiberData()

GetCurrrentFiber()

ConvertThreadToFiber()

The return type of CreateFiber() API is

VOID

LPVOID CONCEPT

HANDLE

BOOL

Which one of the following is not a Process or thread synchronization object?

Fiber CONCEPTUAL

Critical Section

Mutex

Semaphore

VVYVY

109.

110.

I11.

VVVY VVVVY VVVV VVVY

112. Interlocked functions apply to integers.
32 bits signed

32 bits unsigned

64 bits signed

64 bits unsigned

Y V VYV

113. Which one of the following is not a requirement for correct thread code?
Global Storage

Volatile Storage

Memory Barrier

Critical Code Region

Y VVY

114. The return type of CreateSemaphore() API is

DWORD

HANDLE

BOOL TOPIC 147
VOID

VVYVYY

115. The code region where only one thread can execute at a time is known as
program

critical section CONCEPT

non — critical section

Exception Handler

VVVYVYY
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116

YVVVY

117.
to MSDN?

Y VVY

118.

YV VYV

119.

Y V VYV

120.
threads need access to a shared resource.

Y VVY

121.

Y VVY

122.

VVYVYY

123.

YVVVY

Which one of the following APIs block a thread if another thread is in the section?
InitializeCriticalSection

EnterCriticalSection

DeleteCriticalSection

LeaveCriticalSection

Which one of the following numbers is good spin count for heap management according

1000
2000
3000
4000 TOPIC 162

Which one of the following concepts limit the number of active, contending threads?
Mutual Exclusion

Thread Contention

Semaphore Throttle CONCEPT

Parallelism

Which one of the following APIs returns a pointer to a PTP_WORK structure?
TrySubmitThreadpoolCallback

WaitForThreadpoolWorkCallbacks

CreateThreadpoolWork TOPIC 169
SubmitThreadpool Work

Thread synchronization is a process of handling situation when or more

One
Two
Three
Four

Which one of the following options best describe the mutex?
is a binary mutex

does not have handles

must be accessed from only one process

can be accessed from multiple processes

What will happen if a non-recursive mutex is locked more than once?
Starvation

Deadlock CONCEPT
Critical Section

Semaphore

What are the two kinds of semaphores?

mutex & counting

binary & counting CONCEPT
counting & decimal

decimal & binary
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124.

125.

YV VYV

function is supported only on the Itanium processor.
InterlockedExchangeAdd
InterlockedExchange
InterlockedExchangeAcquire
lockedCompareExchange

Instead of starting a new thread for every task to execute concurrently, the task can be

passed to a

126.

127.

128.

129.

130.

131.

VVYVYY YV VY VVVY VVVYVY Y VVY

VVVYY

YV VVY

process

thread pool CONCEPTUAL
thread queue

CPU

Each process has its own process affinity mask, which is a vector.
Bit TOPIC 180

byte

Nibble

Word

Which one of the followings is not a feature of named pipes?
message-oriented

unidirectional TOPIC 184
independent instances of pipes

Networked clients can be accessing pipes by name

Which one of the following is not a characteristic of Anonymous pipe?
Character based

Half Duplex

Full Duplex TOPIC 181
Communicate with Linux & UNIX both

Which one of the followings has two handles: Read handle and Write handle?
Named Pipes

Anonymous Pipes TOPIC 181
Unnamed Pipes

Interposes Pipes

The return type of CreatePipe() APl is

DWORD

HANDLE

BOOL TOPIC 182
VOID

Total number of parameters required for CreateNamedPipe() API is
8 TOPIC 186
9

10

11
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133.

VVVY

Number of parameters taken by OpenFileMapping()?
> 0

> 2
> 3 TOPIC 73
> 1

What the return Type of InterlookedExchange()?

LONG 100% CONFIRM
BOOL

DWORD

LOPVOID

PREE-POST ASSISMENT TOPIC-WISE

134.

135.

136.
ID and other related information

137.

138.
interleaved manner.

YV V V V YV V V V

A\

YV YV V

YV VYV

>
>

The GetCommandLine() function returns the command line as a single
Float variable

Integer Array

Integer Variable

Character string Topic 101

Simple job management shell will allow  commands to run.

Two

Five

Three Topic 104 (jobbg,jobs,kill)
Four

In job management shell the shell uses  specific file keeping track of process

Shell

Process

System

User Topic 104

Process identify can be obtained from the structure.
CreateProcess()

CREATE PROCESS()

PROCESS INFORMATION Topic 93

GetProcessInfo()

[fthe systemis  time is multiplexed among multiple processes in an

Uniprocessor system Topic 99
Linear processor system
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139.

>
>

Multicore processor system
Multiprocessor system
If a system is then windows scheduler can run process threads on separate

Pprocessors.

140.

141.

142.

143.

144.

145.

146.

>

YV V V YV V VY V YV V V V YV VYV V YV V. V Y YV V

VV VY

Y

Uni processor

Linear processor

Single core processor

Multiprocessor Topic 99
FILETIME parameter of GetThreadTime() functionisa _  bit value.
§2

8

16

64 Topic100
Closing the child process handle the process.

Does not create

Create

Destroy

Does not destroy Topic 93
Closing the child process only closes the access of the

All parent process

Parent process Topic 93

All children processes of parent process

Child process

In windows, there are ways to get command line parameter for a process.
Two Topic 96

Four

Five

Three

Ip ApplicationName handle’s value ~ be NULL.

Should

Should not According to me

May

May not

Control of a running fiber can be given to another fiber by using --------- function.
GetCurrentFiber()

SwitchToFiber() Topic 129
CreateFiber()

ConvertThreadToFiberEx()

A thread can enable fiber operation by calling  function.
GetCurrentFiber()
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147.

148.

149.

150.

YV VYV YV VYV

YV V VYV

» SwitchToFiber()

CreateFiber()

ConvertThreadToFiberEx() Topic 129

Inherited handles are  copies that a parent and child might be accessing.
Connected

Similar

Distinct Topic 118

Related

A fiber can obtain its identity by calling function.

GetFiberData()

GetCurrentFiber() Topic 129

GetFiberld()

GetFiberldentify()

The  function is used to obtain the process handle using the process ID.
openProcesses()

GetCurrentProcess()

OpenProcess() Topic 93

OpenprocessID()

Parent process usually creates a handle if parent and child process require

access rights.

151.

152.

153.

154.

VV VY YV V V V

YV V VYV

YV V V

Duplication, same

Duplication, different Topic 94

New, same

New, different

There are ------ APIs to manage fiber.

10

9

7 Topic 129

8

One process can finish another process using the function
FinishProcess()

CreateProcess()

ExistProcess()

TerminateProcess() Topic 95

The simplest form of synchronization can be achieved through  construct.
Run

Halt

Lock

Wait Topic 96

The single object for which the process waits is activated by
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AL-

155.

156.
WAITOBJECTS

157.
wait.

158.
159.
160.

161.
to release resources.

YV V VYV V VYV VYV V

A\

V VYV V VV VYV Y V V

YV V V V

YV V V V

>
>

IpHandle
bWaitAll
hHandle Topic 96
nCount
The array of handles for which the process wait is activated by
IpHandle Topic 96
hHandle
nCount
bWaitAll
is the number of objects in an array. Should not exceed MAXIMUM

IpHandle
hHandle
nCount Topic 96
bWaitAll
is the timeout period for wait. 0 for no wait and INFINITE for indefinite

IpHandle

hHandle

nCount

dwMilliseconds Topic 96
handle describes if it's necessary to wait for all the objects to get free

IpHandle

hHandle

nCount

bWaitAll Topic 96

How many The possible return values are

2

3

4

5 Topic 95

The timeout period for wait() function is measured in

Millisecond Topic 96

Kilo hertz

Mega hertz

Microsecond

Its not a good idea to use within the program as it will not give it a chance

createProcess()
TerminateProcess()
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162.

163.

164.

165.

166.

167.

168.

» ExitProcess() Topic 95
» FinishProcess()
A new fiber can be created by using
ConvertThreadToFiberEx()
ConvertThreadToFiber()
CreateFiber() Topic 129
GetFiber()
In Environment Block, I[pNameisa  name.
Stack
Array
Process
Variable Topic 97
In Environment Block, GetEnvironmentVariable() function returns ~~ in case
of failure.

> 0 Topic 97
NULL
-1
UNDEFINED
In Environment Block, PATH is an example of an environment
Stack
Array
Process
String Topic 97
An Environment Block is associated with process(es) in the system.
Some
No
Each and every Topic 97
Exactly one
In Environment Block (EB), each string is
» Five character long
» Null terminated Topic 97
» Undefined
» Empty

YV VYV V VV VYV YV VYV V

YV V V V

VV VY V

The wait() function is limited to handles.
> 32
> 8
> 64 Topic 98

A value will cause a thread to move from the running state to the ready
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170.
171.
L/2
173.

174.
to another thread if there is one that is to run.

175.

176.

YV VYV YV V V VV VYV YV V V YV V VYV VYV V VY

VV VYV

YV V V

Negative

INFINITE

1

0 Topic 127

Fiber which is shared to different threads

Should not access private data

Should not access global data

Should access thread specific data

Should not access thread specific data Topi 128

Fibers are scheduled by the

Hardware

Operating system

Application Topic 128

BIOS

IPC stands for

Inter process communication My Point of View
Inter privacy communication

Information process communication

Information and privacy communication

The sleep function allows a thread to move the to the state.
Running, Suspended

Running, terminated

Running, ready

Running,wait Topi 127

The function SwitchToThread() provides a way for a thread to yield its processor

Ready, Running

Running, Running

Ready, Ready Topic 127
Running, Ready

The time period in sleep function is specified in
Seconds

Milliseconds My point of View
Nanoseconds

Microseconds

Default stack size for a thread is .

IMB Topic 126
1 Byte

1 Bit

1KB
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A scheduler will move a threads tothe  state if the threads time

shce expires without the thread waiting.

» Waiting, Waiting
» Running, Ready Topic 125
» Running, Waiting
» Waiting, Ready
178. When a thread is suspended it goes into
» Terminated state
»> Waiting state
» Suspended state
» Ready state Topic 125
179. A thread that is ready but do not have required resource will go into
» Running state
» Suspended state
» Waiting state My point of View
» Execution state
180. The scheduler will runthe ~ priority  thread when a processor becomes
available.
» Highest, ready Topic 125
» Lowest, ready
» Highest, running
» Lowest, running
181. If there are no THREAD PRIORTY TIME CRITICAL thread, the process will
run first.
» THREAD PRIORTY LOWEST
» THREAD PRIORTY NORMAL My point of View
» THREAD ORIORITY BELOW_ NORMAL
» THREAD PRIORTY IDLE
182. Which of the following priority is the highest class in the thread?
» THREAD PRIORTY ABOVE HIGHEST
» THREAD PRIORTY TIME CRITICAL My point of View
» REALTIME ORIORITY CLASS
» THREAD PRIORTY HIGHEST
183. The range of relative thread priorities is between
» 0tol
> 0to4
> -2to+2 (+-2) Topic 123
> -1to+1
184. Which of the following thread priorities will run first?
» Thread with THREAD PRIORTY ABOVE NORMA My point of View
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>

>

>
185.

YV VYV

186.

YV V.V

187.

Thread with THREAD PRIORTY BELOW _ NORMAL

Thread with THREAD PRIORTY_ IDEAL

Thread with THREAD PRIORTY NORMAL

In windows, most common processes have priority class
HIGH PRIORTY CLASS

IDLE PRIORTY CLASS

NORMAL PRIORTY_ CLASS My Point View
REALTIME PRIORTY_CLASS

The value returned using TIsSetValue() function is in the form of
BOOL My Point of View
INT

LPVOID

DWORD

In Thread Local Storage (TLS) arrangement, row represents while column

represent

A7

YV V V

188.

YV V V V

189.

Thread TLS Index Topic 123

Process Number, TLS Index not sure

TLS index, Thread

Thread, process Number

Which of the following function frees the specified index numbers?

TIsClear()

TIsFree() Topic 123

TIsReSet()

TIsDelete()

API is used to allocate the index and it returns the TLS index in theform of the

double word

A\

Y VYV V

190.

TIsClear()
TIsAlloc() Topic 123
TIsReSet()
TIsDelete()
Provided valid indexes are used, The programmer can access TLS

spaceusing these simple GET/SET APIs

A\

YV V V

191.

Y VY

TlsGetValue ()

Both A and C Topic 123
TlsSetValue ()

TIsDelete()

In the form of failure, TIsAlloc() function returns_
DWORD

0

-1 Topic 123
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BOOL
192. Which of the following is a correct statement?
Every worker work with multiple processors on multiple processor
Every worker work as a separate thread on a separate processor ~ Topic 122
Every worker work as a separate thread on a single processor
Every worker work with multiple processors on single processor
193. Which of the following is an optimal situation?
» After certain limit processor speed can also be enhanced
» After certain limit processor speed cannot be enhanced Topic 122
» Multiprocessing is not responsible for multiple flows of execution
» Output of parallel program should not be same when it is serialized
194. Which of following statement is incorrect?
» Program performance can be scaled without any certain limit.
» Program performance can be enhanced by using multithreading.
» Program performance can be enhanced with Parallelism.
» Program performance scales automatically, up to some limit.
195. Four threads are created i.e. thread 0, thread 1, thread 2, and thread 3 and are
running to sort a large file, select the most appropriate statement?
» Wait for thread 1 to complete and merge it with thread 2.
Wait for thread 0 to complete and merge it with thread 2.
Wait for thread 1 to complete and merge it with thread 0. My point of view
Wait for thread 2 to complete and merge it with thread 0.
196. Why a file is always mapped before accessing it?
To access it just like accessing some data from main memory My point of view
To make it secure

YV V V

Y V V

To reuse it any time

To access it in the form of LinkedList

197. Once all the threads are created, then can be run using function.

ResumeThread()

ReadyThread()

RunThread() Topic 121

StartThread()

198. The basic difference between boss-worker thread model and client-server model
is

VV VYV

YV VYV V

> In boss worker all the thread are run at the boss’s end, but in client-server model,
each client run a different thread
> In the client-server all the thread are run at the server end, but in the boss worker
model, each worker runs different thread = Conceptual
199. Which of the following is not a thread model?
» Peer-to-peer Topic 119
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Pipeline

» Boss-worker

» Client-server
200. In client server model, rather than  work is done
Concurrently, sequentially
Problematic, Efficiency
Sequentially, Concurrently Topic 119
Linear, Straight

YV VYV

201. In which of the following models, work moves from one thread to the next
thread?

\ 4

Peer-to-peer Model

Pipeline Model Topic 119

Boss-worker Model

Client-server Model

202. The  flagis set to be in the CreateProcess() function, which will
determine whether child process will inherit copies of parent open handles.

Y VY V

» DblInheritFlag, FALSE
» DblInheritHandle, TRUE My point of View
» blnheritFlag, TRUE
» blnheritHandles, FALSE
203. Inherited handles are copies that a parent and child might be accessing
» Similar
» Connected
» Distinct Wikipedia
> Related
204. The get.JobNumber() function looks into the file for a vacant place. If no place is
available, It appends a new record at the
» Next
» Start
» Middle
» End My point of View
205. In getting a job number, the job Management Shell uses a number of job
management functions to manage jobs information within the ~ life.
» Process
» User Topic 103
» Shell
» System
206. Fiber management occurs at the level.

» Hardware
» User space Topic 128
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AL-

>

207.

>
>

A\

208.

YV VYV V

209.

VV VY

210.

211.

212.

213.

Y YV V YV V V V YV VYV \7\7\7\7‘

Kernel

BIOS

In Asynchronous input/ Output

Input from the keyboard will be taken after the song is ended.

Song cannot be played until the other operations are not completed.
Song can be played with other operations being executed same time.

Topic 119 also Conceptual (correct Accordingl

Two operations cannot be run at the same time.

The first two parameters in argc will be and respectively.
Process name, pattern which is to be searched  Topic 118

Inputted file names, pattern to be searched

Pattern to be searched, process name

Inputted file names, process name

Total number of files inputted, can be obtained with -

Argc-1

Argc-2 Topic 118 (Confusion kindly Correct Accordingly)
Argc-3

Argc

C Library Threading functions are

than windows library functions but not
Simpler, Hard
Hard, Simpler
Diverse, Simpler
Simpler, Diverse Topic 118
LIBCMT is a
BIOS Library for thread
Java Library for threads
C Library for threads Topic 118
Windows Library for threads
function is used to extract  from a string.
gettok(), Token
getTok, String
strtok(), String
strtok(), Token Topic 118
The return type of _beingthreadex() function
is HANDLE, but we need to type caste it for further processing.
Is not HANDLE, but we cannot type caste it for further processing.
is not HANDLE, we need to type caste it for further processing.

Topic 118 Conceptual
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» is HANDLE, but we don’t need to type caste for further processing.

214. library function are thread safe than  library functions.
» C,java
» Java, C
» C, Windows Topic 118
> Windows, C
215. Windows treats threads as .
» Objects Topic 116
» Threads
» Processes
» Classes
216. When a thread exits, the thread is deallocated and the handle referring to
the thread in invalidated.
» Stack Topic 113
» List
» Queue
» Array
217. ResumeThread() function will
» Decrease the value of suspend count Topic 112
» Reset the value of suspend count
» Increase the value of suspend count
» Not affect the value of suspend count
218. By default, the value of Suspend count, when creating a thread, is
> 2
> 1
> 0 Topic 112
> -1
2109. Which of the following version of windows was not compatible with
GetProcessIdOfThread() function?
» Windows 2003
» Windows 7
» Windows NT
» Windows XP Topic 115
220. Which of the following function can be used to map a process with a thread?
» GetProcessIdOfThread() My Point of View
» DWORD ResumeThread (HANDLE hThread)
» DWORD SuspendThread (HANDLE hThread)
» GetThreadOPendingFlag()
221. A thread will execute if and only if its Suspend Count value is
» Non zero
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>
>
222.
that.

YV V VYV

223.

YV VV V

224.

Above 1

0 Topic 115

1

Threads can also be treated as parent and child although the is unaware of

Kernel

Thread

Program

Operating system Topic 112
Threads share resources within a

Code

Program

Thread

Process Topic 110
Threads uses the space assigned to a

» Thread

» Process Topic 111
» Code

» Program

225.

YV V V V

226.

YV V V VY

227.

In a multi-threading system, multiple threads may exist within a single
Thread
Process Topic 109
Code
Program
is an independent unit of execution within a process.
Thread Topic 109
Process
Code
Program
A job object 1s used to process execution time and obtain user time

statistics.

A7

YV V V

228.

Limit Topic 108

Write

Read

Open

The getJobNumber() function looks into the file for a vacant place. If no place is

available, it appends a new recover of the file.

>
>
>

Start
Next
Middle
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» End My Point of View
229. In job Management Shell, the shell uses specific file keeping track of
process ID and other related information.

» User Topic 104

» Process

» Shell

» System
230. In finding a Process ID, the FindProcessId() obtains the process ID of the given
the record at the specific location.

job number. It simply looks on job number and
» Sums

Executes

Reads Topic 106

Writes

231. Simple job management shell will allow commands to run.

Two

Three Topic 104 (Jobbg, jobs, kill)

Four

Y V V

YV VYV V

Five

232. In listing background jobs, the job management function uses display jobs ()
function. This function a file

Run

Start

Process

Open Topic 105

233. In Job Objects, firstly a job object is created using CreateJobObject(). It
a name and security attributes.

Writes

Closes

Uses Topic 107

Throws

234. Control of a running fiber can be given to another fiber by using function.

GetCurrentFiber()

SwitchToFiber() Topic 129

CreateFiber()

ConvertThreadToFiberEx()

235. A thread can enable fiber operation by calling function.

GetCurrentFiber()

SwitchToFiber()

CreateFiber()

ConvertThreadToFiberEx() OR ConvertThreadToFiber() Topic 129

Y

YV VYV Y VYV V

VV VYV

YV V V V
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Fiber can obtain its identity by calling

GetFiberData()
GetCurrentFiber()
GetFiberld()
GetFiberldentity()
237. There are

10

9

7

8

YV V V

VV VYV

function.

Topic 129

APIs to manage fibers.

Topic 129

238. A new fiber can be created by using

ConvertThreadToFiberEx()
ConvertThreadToFiber()
CreateFiber()

GetFiber()

YV VYV

299. The wait() function is limited to

32
16
8

64

VV VYV V

Topic 129

handles

Topic 98

240. Windows OS does not have any structure that keeps track record of the

processes.
Child
Grand-child
Parent
Parent-Child

A7

YV VYV V

My point of View

241. In comparison of DLL, executable library files are linked at time.

Link

Run

Compiler

Load

242. Interlocked functions are

YV V V

My Point of View and GOOGLE

to use.

Simpler, Faster but hard
Simpler, Faster and easy

Not simpler but faster and easy
Simpler easy but slow

243. Thread should not change the
Process

Hard disk

Integer

YV V VYV

Y YV V

Topic 135

environment.
Topic 137
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244.

245.

objects provided by

246.

247.

command line as a single

248.

249.

250.

251.
the

-JUNAID TECH INSTITUTE

Which of the following function can be used to map the process with thread?
DWORD Resume Thread (HANDLE hThread)

DWORD Suspend Thread (HANDLE hThread)

GetProcessIdOfThread() My Point of View
GetThreadlOPendingFlag()

Mutexes, Semaphores, Events, and Critical Section are the four synchronization

YV VYV

A\

Software

RAM

Windows Topic 138

processor

Like every other resource, threads are also treated as

Code

Object Topic 112

Program

Thread

The process Execution times uses the API GetCommandLine() to get the

VYV VYV V

YV VYV

Y

Bool

Float

String Topic 102

None

IpApplicationName be NULL.

May

Should

Should not My point of View
May not

Volatile stage is a level facility.
Compiler or windows Topic 133
Programmer

BIOS

Hardware

CRITICAL_SECTION Objects do not have
Loops

Handler Topic 139

Variables

Process

CRITICAL SECTION Objects do not have  and are not shared among

Y YV V

VV VY V

YV V V

VV VY
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252.

253.

254.

255.

256.

257.

258.

Handler
Both A and C Topic 139
process
Process

YV VYV VY

variables should not be accessible globally.

String
Locally required Topic 139
Long

YV V VYV

Integer

Thread IDs and handles can be obtained using functions quite similar to the ones
used with

Process Topic 114

Program

Thread

Object

A thread can be signaled from which of the following?

ResumeThread()

CloseThread()

CreateThread()

ExitThread() OR TerminateThread() Topic 117

If there are 129 objects, how many times we will have to call the wait () function?
4

6

3 My Point of View

2

ResumeThread() function will

Increase

YV V V

VV VYV V

YV V V

Decrease Conceptual

None of given

Both

[f you want to create 4 thread i.e, thread 0, thread 1, thread 2, and thread 3, they
all must be created at  state.

Suspended Topic 120

Blocked

Running

Ready

It must be ensured that ~ thread(s) is/ are not modifying  data at same

YV VYV

A7

VYV V VYV

time.

A\

Many, Many
> 1, Many
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» Many,l Topic 131 Conceptual
> 1,1
259. The result of concurrent processing and normal processing
Yield same output

[s always different
[s always same
May differ in some cases My point of View

YV V VYV V

260. In memory architecture and barriers, before writing the value s back to memory,
the processor usually keeps them in

Hard disk

Memory card

Processor

Cache Topic 134

261. are used to ensure that memory is accessed in the desired order.

Memory barriers or memory fences Topic 134

Memory paths or memory houses

Multi processors

A\

Y YV V

YV VYV V

Memory blocks or memory chains
262. Turning off may adversely affect the performance but sometimes may
the program.
» Usability, faster
» Optimization, slow Topic 133
» Performance, slow
» Security, faster
263. Turning off Optimization may adversely affect the performance but sometimes
may slow the program. ANSI C provides a qualifier for this purpose.
» Volatile Topic 131
» Non-volatile
» Both A and B
» None of Given
264. The volatile qualifier does not guarantee that the modifications will be visible to
in a desired order.
Processors Topic 134
User
Ram
Hard disk
265. The  functions provide memory barriers.
Interlocked Topic 139
User define

YV V V V

Y VY

» Interchange
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266.

267.

268.
incremented,decremented and exchanges

269.

270.

271.
variables are initializes.

272.

>

VV V VY YV V V V YV V V

A7

YV V V

YV V V

» Intermediate
Interlocked increment () takes a 32-bit signed variable as an arguments, which
should be placed in memory at the boundary.
> 4-byte Topic 135
> 8-byte
» 16-byte
» 2-byte
[f a variable with a volatile scope only needs to be incremented, decremented, or
exchanged, interlocked functions are the choice.
» Last
> Best Topic 135
> 2% ast
> Worst
are most suited if variable with volatile scope only need to be

Interlocked functions Topic 135
Local

Global

None

The most basic of Interlocked Functions
Interlockedincrement()

InterlockedDecrement()

Both A and B Topic 135
None of Given

How many Basic Function of Interlocked()

1

2 Topic 135
3

4

[f any needed variables are not initialized, then create ~ threads until

Suspended Topic 137
Double

Slow

Fast

In thread safe code, conditions are avoided.
Race Topic 137
Loop

Local

Global
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When more than one thread can run the same code without introducing

synchromzatlon issues, it is said to be

>

Y YV V

274.

Thread safe Topic 137

Local

Threaded

Initialized properly

InterlockedIncremen64() and interlockedDecrement64() can be utilized on 64-bit

systems if the addend is paced at the boundary.

A\

YV V.V

275.

YV VYV

276.

YV V V

277.

VV YV V

278.

8-byte Topic 135
4-byte
2-byte
16-byte
have a performance disadvantage since they create a memory barrier.
Interchanged function
Interlocked function Topic 135
Intermediate function
Interlocked memories
Ifa is used to store thread-specific data, other threads will also use it.
Small variable
Large variable
Global variable topic 136
Local variable
Make a variable  if we know it includes thread-specific information.
Static
Local Topic 136
Global
Random
According to the criterion for good thread code,  storage should not be used

for the purpose of local storage.

A\

Y VYV V

279.

make it

>
>
>
>

Hard disk

Global Topic 136

Cache

Ram

If we know the information in a variable will be used by other threads, we can

Global Topic 136
Local
Main
Auto
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When using thread synchronization objects, there are always inherent risks

assoc1ated with them such as

>

Y YV V

281.

Lower power

Multi clocks

Load

Deadlocks Topic 137

A thread waits for other threads to  using the waitForStringObject() or

waitForMultipleObjects() methods.

A\

YV V.V

282.

Wait

Terminate Topic 138

Start

Update

The part of the code that can only be executed by one thread at a time is referred

to as the

Y

YV VYV V

283.

YV V V V

284.

YV V VY V

285.

YV V V

286.

Process section

Loop section

Top section

Critical section Topic 139

Only  canbeinthe CRITICAL SECTION variable at a time
Odd threads

Many threads

One thread Topic 139

Even threads

Which function is used to initialized the CRITICAL SECTION.
InitializeCriticalSection() Topic 139
DeleteCriticalSection()

Both A and B

None of Given

Which function is used to Delee the CRITICAL SECTION.
InitializeCriticalSection()

DeleteCriticalSection() Topic 139

Both A and B

None of Given

Multiple threads may call EnterCriticalSection() but only thread is

allowed to enter the critical section while the rest areblocked.

A\

Y VYV V

287.

One Topic 139
Two

Three

Foure

A call to LeaveCriticalSection() must match a/an_
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288.

289.
enter the critical section, while the others are blocked.

290.

291.

VYV VYV V

YV V'V YV V VYV

VV YV V

» EnterSection()

Variables

EnterCriticalSection() Topic 139
CriticalSectionPart()

CRITICAL SECTION object do not have
Process

Variables

Handles Topic 139
Loops

EnterCeriticalSection() can be called by but only one of them is allowed to

Two threads

One thread

Half thread

Many threads Topic 139

Using the critical section constructis  and intuitive.

Easy Topic 140

Difficult

Short

Long

It would be  to use different objects in the same thread or across numerous

threads that share the same data.

292.
object across all threads.

293.

294.
window?

A7

VYV VYV V

A\

Y VYV V

VV VY

>

Easy

Incorrect Topic 141

Correct

Difficult

For mutual exclusion to work,  variables must be protected by a single

Integer

Important

Shared Topic 141

specific

Within the critical section, all the variables must be guarded by

Critical object

All objects

A single object Topic 141

Double object

What is the limit for object to be waited for waitForMultiple Objects () function in

63
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> 62

> 64 Topic 141
295. Producer consumer problem is a classical problem in
Critical Section
Conical collection
Mutual Exclusion Topic 142
None of given

YV VYV

296. The producer periodically ~ a message.
Creates Topic 142
Delete
Update
None
297. The producer also computes a simple of the message
Checksum Topic 142
Contents
Update
None
298. is a short form of Mutual Exclusion
Mechanism
Checksum
Mutex Topic 143
All of the given
299. Which of the following Windows functions used to manage mutexes.
CreateMutex()
ReleaseMutex()
OpenMutex()
All of the given Topic 144
300. Home Many windows Function are used to manage mutex.
1
2
3 Topic 144
4
301. IpMutexName is the name of the mutex.
True Topic 144
False
302. OpenMutex() is used to and named mutex
» Existing,open
» Open,Existing Topic 144
» Open,Delete

YV VYV YV V VYV V YV V V V YV VYV V YV V.V

vV VY
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>

303.
Mutex waits can

>

Y YV V

304.

YV VY

305.

306.

YV V VYV

307.

YV V V V

308.

YV V VYV V

309.

YV VYV

310.

VYV VYV V

311.

reset.

Exsiting,Delete
However, abrupt termination of a thread indicates a serious programming flaw.

Time In

Time Out Topic 146
Has

Does Not

[f NULL is returned it indicates dose not failure.

True

False Topic 144
Semaphore maintains a count

» True Topic 147
» False

A semaphore is in a signaled state when the count is greater than.
1

-1

0 Topic 147
None of given

Semaphore is when the count is 0.

Signaled

Un-signaled Topic 147
Release

None of the given

Which of the following are used in semaphore Count?
CreateSemaphore()

CreateSemaphoreEx()

OpenSemaphore()

All of the Given Topic 147
cReleaseCount gives the count after the release and must be greater than .
1

-1

0 Topic 147
None of given

Events are classified as either

manual-reset

auto-reset

Both A and B Topic 150
A event can signal several waiting threads simultaneously and can be

manual-reset Topic 150
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312.

313.

314.

315.

316.

317.

318.

319.

320.

» auto-reset
An event signals a single waiting thread, and the event is reset
automatically.
» manual-reset
» auto-reset Topic 150
If blnitialState is TRUE, the event is set to a state
» Signaled Topic 150
» Un-Signaled
If the event is manual-reset, it remains signaled until a thread explicitly calls
ResetEvent().
» True Topic 150
» False
How many ways to use Events?

VV VYV
A W N =

Topic 151
Windows operating system is a multithreaded that provides support
for real time applications and multiprocessors.
Hardware
User space
Kernel Topic 153
BIOS
Program design and performance can be simplified and improved by
Odd threads
Many threads
Threads Topic 153
Even threads
Synchronization is a way to coordinate processes that use shared data
Shell
Process Topic 153
System

Y

Y YV V

VV VY V

YV V V

User

Which of the following Synchronization objects.

Critical Section

Semaphore

Mutex

All of the Given Topic 153

The functions provide a simple mechanism for synchronizing access to

VV VY

a variable that is shared by multiple threads.
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Interlocked Topic 155
> Local
» Global
» None
321. Memory allocation is then performed using using rather than

using
» HeapAlloc() and HeapFree(),malloc() and free()  Topic 56
» malloc() and free() and HeapAlloc() and HeapFree(),
322. Each thread that performs memory management can create a Handle to its own
heapusing
» HeapCreate() Topic 156
HeapAlloc()
HeapFree()
None of the given
823 Threads allocate memory and free memory using functions respectively
malloc () and free () Topic 156
free () and malloc ()
324. How may aspects compare the performance on the Basis.
1
2
3 Topic 157
4
325. Which of the Following aspects that are used to compare the Performance.
Real-Time
User-Time

Y YV V

Y V

YV V V

System-time

All of the given Topic 157

326. MX(Mutexes) version costs more than times than IN
2 times

2 to 30 times Topic 158

1 to 30 times

3 times

327. CS (Ceritical Section) version costs times more than IN
2 to 30 times

2 times Topic 158

1 to 30 times

3 times

328. For older version of windows CS was not scalable.

True Topic 159
False

VV VYV

VV VYV YV V V

Y VY
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Critical Section works in

Hardware

User space Topic 161

Kernel

BIOS

330. How many methods of Lightweight Reader Writer Locks.

1

2 Topic 163

3

4

331. Which of the following methods of Lightweight Reader Writer Locks
Exclusive Mode

Shared Mode

Both A and B Topic 163

None of given

332. How many APIs which are used to access SRWs in Exclusive mode.
1

YV V V

YV V VYV

YV VYV

Topic 164

YV V V V

2
3
4

333. When a thread is created almost  space is reserved for that thread and with
increasing threads memory area is piled up.
> 1 MB Topic 166
> 1KB
> 1Bit
> 1 Byte
334. If you the threads the you can lose the benefits of parallelism and
synchronization
» Minimize Topic 166
» Maximize
335. Which of the following optimization technique?
Use of semaphore throttles
Asynchronous I/O
Using I/O completion ports
All of the Given Topic 166
336. Every process has a dedicated pool.
Odd threads
Many threads

YV V V

Y VY
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» Threads Topic 172
» Even threads
337. The thread pool is used to the number of application threads and provide

management of the worker threads

» Increased
Reduce Topic 172
Constant

Y YV V

Equal

338. How many types of call back Function.

1

2 Topic 173
B

4

339. How many sorts of parallelism?

1

2 Topic 177
3

4

340. Which of the following parallelism define every loop iteration can execute

YV VYV

YV VYV V

concurrently.
» Loop parallelism Topic 177
» Fork-join parallelism
341. the control flow divides (like the shape of the fork) into multiple flows
that join later
» Loop parallelism

» Fork-join parallelism Topic 177
342. Each process has its own process affinity mask and a system affinity mask.
» True Topic 180
» False
343, How many Bits vector of MASK?
> 1
> 2
> 3 Topic 180
> 4
344. Which of the follwing Bits vector of MASK?
» System Affinity Mask
» Process Affinity Mask
» Thread Affinity Mask
» All of the Given Topic 180

345. IPC stand for
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346.

347.

348.

349.

350.

351.

352.

353.

354.

YV V V

Y V

VY V

YV V VYV YV V V VY Y V VV VYV

YV VY

Internet process control

Inter-process Communication Topic 180
Inter-parameter control

None of the Given

How many Types of Pipe?

1

2 Topic 181 (Anonymous Pipes, Named
Pipes)

3

4

File-like object called Pipe can be used for IPC.

True Topic 181

False

Which of the following are correct statement of Anonymous Pipes?

Simple anonymous pipes are character based and half duplex. Topic 181
They allow network wide communication.

Which of the following are correct statement of Named Pipes?
There can be multiple open handles for a pipe

They allow network wide communication.

Much more powerful than anonymous pipes

All of the Given Topic 181
Anonymous pipes allow (half-duplex) communication
one-way Topic 182
two-way

The default set of cbPipe is

0 Topic 182

1

2

3

Named Pipeis

Directional

Bi-Directional Topic 184
Tri-Directional

None of the Given

The pipe name would be like this.

\.\pipe\[path]pipename Topic 187
\\servername\pipe\pipename

Which of the following connection sequences for the Client.

The client connects with a server
Communicates with the server using CreateFile()
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Performs Read and Write operations and ultimately disconnects

All of the given Topic 190

Which of the following connection sequences for the Server.

Communicates with the client.

As a result ReadFile() returns FALSE

The server-side connection is disconnected

All of the given Topic 190

Which of the following Returns information whether the pipe is in blocking or

non-blocking mode, message oriented or byte oriented, number of pipe instances, and so

355.
>
>
>
>

356.

on.

>
>
>
>

R5%

SetNamedPipeHandleState()

GetNamedPipeHandleState() Topic 188

GetNamedPipelnfo()

None of the given

Which of the following Allows the program to set the same state attributes. Mode

and other values are passed as reference so that NULL can also be passed indicating no
change is desired.

>

>

>

>
358.

SetNamedPipeHandleState() Topic 188
GetNamedPipeHandleState()

GetNamedPipelnfo()

None of the given

Which of the following Determines whether the handle is for client or a server,

buffer sizes, and so on.

>

YV V V

359.

YV V V

360.

VV VYV

361.

Y VY

SetNamedPipeHandleState()
GetNamedPipeHandleState()
GetNamedPipelnfo() Topic 188
None of the given
Call to disconnect from the handle
DisconnectNamedPipe() Topic 189
WaitNamedPipe()
ConnectNamedPipe()
All of the given

is used to synchronize connections to the server
DisconnectNamedPipe()
WaitNamedPipe() Topic 189
ConnectNamedPipe()
All of the given

are the security attributes as discussed previously
IpSecurityAttributes Topic 186
nOutBufferSize
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» dwOpenMode
» nMaxInstance
362. and give the size in bytes of input and output buffer
nOutBufferSize and nInBufferSize Topic 186
nInBufferSize and nOutBufferSize
363. which of the following determines maximum number of pipe instances?

Y VY

IpSecurityAttributes

nOutBufferSize

dwOpenMode

nMaxInstance Topic 186

364. which of the following indicates whether writing is message oriented or byte
oriented?

dwPipeMode Topic 186

nOutBufferSize

dwOpenMode

nMaxInstance

365. is the default timeout period.

nDefaultTimeOut Topic 186

nOutBufferSize

dwOpenMode

nMaxInstance

366. The period (.) stands for local machine.

True Topic 186

False

367. In mutex which type of data structure that stores the resource should also be used
to store the mutexes because mutexes correspond to the resources.

» Different Topic 154

Same

Equal

None of the Given

368. Only the Scheduler decides which thread has the priority
according to its scheduling policy.

» Hardware

YV V VYV

VV VY Y VV V

Y V

Y VYV V

» Application

» OS Topic 154
» BIOS
360. The shell uses a ............ file keeping track of process ID and other related
information?
» User-specific Topic 104
370. The array of handles for which the process waits.

> IpHandle
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In Listing Background Jobs the job management function us